Math Projects

Project 9 Tiling the Wall

Solution File
Academic_Project_09_SF.docx
Topics Covered
Math Skills

e Representing the idea of a variable as an unknown quantity

e Expressing mathematical relationships using equations

Finding the area of a rectangle

Using mathematical models to represent and understand quantitative relationships

Using graphs, tables, and equations to draw conclusions

Using the associative, commutative, and the distributive properties of multiplication over addition to
simplify omputations

Computer Skills
¢ Creating and formatting tables
e Keying text into tables

e Modifying font, font style, and font color

Why Do I Need to Know This?

Examining and working with number patterns is an important way to understand relationships between
numbers. In this project, you will find the area of a pattern of tiles. You will then double, triple, and quadruple
the pattern and find the area of the doubled, tripled, and quadrupled versions of the pattern. Performing these
calculations will help you become more familiar with the methods for finding area, and will allow you to
practice creating algebraic expressions.

Before You Begin

There are three sizes of tiles you will work with to make your patterns:

a. Small, square tiles whose length and width measure one unit, dimension = 1 X 1

b. Border tiles whose width, like the small, square tile, is one unit, and whose length, referred to as t, is
the same as the large square length, dimension =t X 1

c. Large, square tiles whose length and width are referred to as t, dimension = t X t or ¢?
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You can make paper models of the tiles shown in Figure 9.1 and use them to create the patterns below, or you

can use algebra tiles to create the patterns.

Figure 9.1
Tile a Tile b Tile ¢
t t
1
1 1 ¢
Area=1x1() Area =1t X 1 (1)
Area =t X t (f)

Figure 9.2 Patterns

Pattern Pattern Pattern Pattern
A B C D
Procedure

1.  Open a new Word document.

2.  Save the file as Academic_Project_09-[first initial and last name].docx. Ask your teacher where
to save your file.

3.  Create a table with five rows and five columns.

4. Label the first column in the table Pattern Style. Label the subsequent columns One, Two,
Three, and Four.

5.  Under Pattern Style, label the rows A, B, C, and D.

6. Modify the font, font style, and font color of the text in your table so that the headings are clear
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Project 9
Figure 9.3 Table to Record Area

Pattern Style One Two Three Four
A t +2t
B
C
D

7. Fill in the table with algebraic expressions that represent the area of each pattern style. For example,
the area for pattern style A in the One column would be t2 2t. To find the area for each pattern style
in columns Two, Three, and Four, arrange each pattern style next to itself the number of times listed
in the column heading. For example, in row A, column Two, the pattern whose area you calculate
should look like Figure 9.4.

8. Save and close your file.

Figure 9.4 Sample Pattern
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Project 9 Rubric

Name

Period

Directions: After you have finished your project, determine how well you have completed each Category. Read the

criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right

column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of Evaluation
. - . i Score and
and Corresponding Excellent (4) | Proficient (3) Developing (2) Beginning (1)
Comments:
Score:
Table Structure and | The table is One heading | Two headings are | More than two
Formatting drawn and is missing or missing or are not | headings are
labeled is not correctly | correctly labeled. | missing or are
correctly. The | labeled. The The table has five | not correctly
table has five | table has five | columns and five | labeled. The
columns and columns and rows. The table table does not
five rows. The | five rows. The | could have been | have five
table is very table is very formatted better. columns and
well formatted. | well formatted. five rows. The
table is poorly
formatted or
has no
formatting at all
Algebraic All algebraic One Two expressions | More than two
Expressions expressions in | expression is | are incorrect. expressions are
the tables are | incorrect. incorrect.
correct.
Data for Area There are no | There is one There are two There are more
errors in the error in the errors in the data. | than two errors
data. data. in the data.
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Project 10 Comparing the Perimeters and Areas

Solution File
Academic_Project_10_SF

Topics Covered
Math Skills

e Finding the perimeter and area of a square
e Collecting data and drawing conclusions from it
e Comparing perimeters of squares
e Comparing the area of squares
Computer Skills
e Formatting a table
* Keying text into a table

e Applying a pre-defined format to a table
Why Do I Need to Know This?

Collecting data and drawing mathematically sound conclusions based on that data is an important skill to
learn. In this project, you will look at five different-sized squares and, using a Word table, you will record the
length of each square’s side, area, and perimeter. You will then use the data to compare the different squares.

Procedure

While working on this project, you will compare the sizes of the following squares shown in Figure 10.1.

Figure 10.1 Squares to Compare

Square A Square B Square C Square D Square E

1. Open a new Word document.

2. Save the file as Academic_Project_10-[first initial][last name]. Ask your teacher where to save your
file.
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Create a table with five columns and six rows.

4. Label the columns from left to right as follows: Square, Length of each side, Perimeter, Area, and
Number of sides inside the square. (See below for an example.)

5. Label the rows under the heading Square as follows: A, B, C, D, E. See Figure 10.2 for an example.

Figure 10.2 Sample Table

Square Length of each Perimeter Area Number of sides
side inside the square
A 1 4 1 0
B 2 8 4 4
C 3
D 4
E 5

6. Complete the table by inserting the correct data. (Note: The length of each side is provided for you.)

7. Go to the Design tab and apply a table style to the table.

8. Create a second table below the first table. It also should have five columns and six rows.

9. Label the columns from left to right as follows: Ratio of square figures, Side length, Perimeter,
Area, and Number of sides inside the square. (See Figure 10.3)
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10. Label the rows under the heading Ratio of square figures as follows (also see Figure 10.3):

Figure 10.3 Ratio Table

Ratio of square Side length Perimeter Area Number of sides
figures inside the square
B 2 8 4 4
A 1 4 1 0
C
A
D
A
E
A
D
B

11. Complete the table by inserting the correct data.

12. Go to the Design tab and apply a table style to the table.

13. Below the second table, key the answers to the following questions,. Label each answer with the letter
that corresponds to the question you are answering. Look at th etable and use the data in it to draw
conclusions about the relationship of squares B, C, D, and E to square A.
a. Issquare B twice as big as square A? Is square E five times as big as square A? How do you know?
b. How do the permeters of squares B, C, D, and E compare to the permeter of square A?
c¢. How do the areas of squares B, C, D, and E compare to the area of square A?

14. Save and close your file.
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Project 10 Rubric

Name Period Date

Directions: After you have finished your project, determine how well you have completed each Category. Read the
criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right
column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of
Evaluation and Score and
. Excellent (4 Proficient (3 Developing (2 Beginning (1
Corresponding @ 3) ping (2) g 9 Comments:
Score:
Design and The columns and | The columns The columns and | The columns and
Formatting of rows in the tables | and rows in the rows in the tables | rows in the tables
Tables are evenly tables are evenly | are not evenly are not evenly
spaced, and the | spaced, and the | spaced, or the spaced, and the
table design table design table design is table design is

enhances the
tables’ readability.
A well-chosen
table style has

makes the tables
easy to read. A
table style has
been applied to

distracting. Table
styles could have
been better

chosen or a table

distracting. No table
styles were applied.

been applied to each table. style was only
each table. applied to one
table.
Data in Tables The data is The data is The data is The data is
recorded without | recorded with recorded with two | recorded with more
error. one error. errors. than two errors.

Conclusions Based
on Table Data

The conclusions
are based on the
data presented.

The conclusions
are partly made
from the data
recorded.

The conclusions
are made from
looking at the
drawings only.

The conclusions
have apparent
basis.

Academic Projects—Math

RUBRIC




Math Projects

Project 11 Bridging the Gap

Solution File
Academic_Project_11_SF

Topics Covered

Math Skills
e Collecting data

e Calculating results

Computer Skills

e Inserting a table

e Formatting a table

Why Do I Need to Know This?

Collecting and analyzing data is an important math skill that is often used in everyday life. In this project, you
will assume the role of a construction superintendent. You will examine a type of bridge and the materials
needed to create the bridge. You will look at what happens to the amount of materials needed as you make the
bridge longer. You will also use a specific shape to create the bridge. Certain shapes can hold much more
weight than others. The strongest shape to hold the weight of a bridge appears to be the triangle. You will base
your work on a shape that is made up of triangle.

Before You Begin

In this project, you will create and then compare bridges of different lengths. You will design these bridges
using girders and rivets. A girder is a beam that is used as a support in buildings and bridges. A rivet is a bolt
that holds girders together.

Since triangles are the strongest shapes, the shape you use will be made up of triangles. The shape is a square
with a diagonal so that the figure is composed of two triangles. This shape is made of five girders and has four
rivets. See Figure 11.1.

Figure 11.1 Girders and Rivets
girder

rivet rivet
® D)
girder " girder
girder
rivet (G D) rivet
girder

You will make a table to show the increase in the number of girders and rivets used when you double, triple,
quadruple, and quintuple this shape to make a bridge.

Academic Projects—Math PROJECT 11



Math Projects

Project 11

Procedure

1. Open a new Word document.

2. Save the file as Academic_Project_11-[first initial][last name]. Ask your teacher where to save your
file.

Create a table with three columns and seven rows. (See below for an example.)

4. Title the first column Number of Shapes, title the second column Number of Girders, and title the
third column Number of Rivets.

5. Complete the table (see the partially completed example below).

Figure 11.2 Example of Table

Number of Shapes Number of Girders Number of Rivets
1 5 4
2 9 6
3
4
5
6

Note what happens when you double the shapes: the two shapes share a girder and two rivets. The
configuration below has 9 girders and 6 rivets. Keep this in mind as you calculate the remaining
configurations.

6. Save and close your file.

Figure 11.3 Girders and Rivets Doubled

rivet girder rivet girder rivet
® © ® D
girder ) girder <:::> ) girder
girder girder
rivet (B 8D rivet G &) rivet
girder girder

Memory Check

If necessary, draw out each scenario and then count the number of girders and rivets.
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Project 11 Rubric

Name Period Date

Directions: After you have finished your project, determine how well you have completed each Category. Read the
criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right
column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of Evaluation

and Corresponding Excellent (4) | Proficient (3) Developing (2) Beginning (1) Score and
Comments:
Score:
Table formatting The table has | The table has | The table has the | The table does
the correct the correct correct number of | not have the
number of number of columns and correct number
columns and columns and rows but it is not of columns and
rows, the rows and is evenly spaced or | rows.
columns and | readable. is not easy to
rows are read.
evenly
spaced, and
the table is
easy to read.
Table data All of the data | One of the Two of the More than two
has been calculations is | calculations are of the
keyed into the | incorrect. incorrect. calculations are
table and is incorrect.
correct.
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Project 12 Solving Inequalities

Solution File
Academic_Project_12_SF

Topics Covered
Math Skills

Solving inequalities involving addition, subtraction, multiplication, and division

Computer Skills

Adding text to a slide

Applying a design template to a slide
Applying a slide animation scheme
Moving among slides in a slide show
Saving a presentation

Printing a presentation

Why Do I Need to Know This?

A mathematical inequality is a comparison of two expressions using greater than (>) or less than (<) signs.
Solving inequalities is an algebraic process that requires many steps to finalize an answer. PowerPoint
presentations provide an efficient way to present ideas, particularly when you want to explain the steps in a
process. Create a PowerPoint presentation that shows the steps for solving different mathematical inequalities.

Procedure

1. Open a new PowerPoint presentation.

2. Save the file as Academic_Project_12-[first initial][last name]. Ask your teacher where to save the
file.

3. Throughout your presentation, use fonts, font sizes, and font styles to make your slides as readable as
possible.

4. Choose the Title Slide layout for the first slide.

5. On the first slide, title your project Solving Inequalities.

6. Go to the Design tab and choose an appropriate theme for your presentation.

7. Select an animation and/or transition for the title slide.

8. Create a new slide and choose the Title and Content layout.
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9. Title this slide Using Addition or Subtraction.

10. In the text box on the slide, key the following text:

Example 1
a + 4 < 14 (Inequality)

- 4 - 4 (Subtract 4 from both sides)
a < 10 (Final answer)

11. Create a new slide and choose the Blank text layout.

12. Create a text box and key in the following:

Example 2
9k —12 > 80 + 8k (Inequality)
-8k — 8k (Subtract 8k from both sides)
k—12 >80 (Result of subtraction)
+12 + 12 (Add 12 to both sides)
k >92 (Final Answer)

13. Select an animation and/or transition for this slide.
14. Create a new slide and choose the Blank text layout.

15. Create a text box and key in the following:

Example 3
6y>14-2+ 7y (Inequality)
-6y -6y  (Subtract 6y from both sides)
0>14-2+ y  (Result of subtraction)
0> 12+ y  (Combine like terms)
-12 —12  (Subtract 12 from both sides)

-12> Y (Result of subtraction and final answer)
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16. Select an animation and/or transition for this slide.
17. Create a new slide and choose the Title and Content layout.
18. Title this slide: Using Multiplication or Division.

19. Key the following text into the text box on the slide:

Example 4

4x <24 (Inequality)
4%6 %Tél (Divide both sides by 4)

x < 6 (Final answer)

20. Select an animation and/or transition for this slide.
21. Create a new slide and choose the Blank text layout.

22. Create a text box and key in the following:

Example 5

-9k >21 (Inequality)

‘g_k 2?1 (Divide both sides by -9)

k < -7 (Reverse the inequality sign in the final answer)
3

23. Select the animation and/or transition for this slide.
24. Create a new slide and choose the Blank layout.

25. Create a text box and key in the following:

Example 6

-3v +3<-21 (Inequality)
-3 -3 (Subtract 3 from both sides of the inequality)
-3v <-15 (Result of subtraction)

-3v <-15 (Divide by -3)
-3 -3
v > 5 (Reverse the inequality sign in the final answer)
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26. Select an animation and/or transition for this slide.

27. Create a new slide and choose the Blank text layout.

28. Create a text box and key in the following:
Example 7

X +1>-5 (Inequality)

-1 -1 (Subtract 1 from both sides)
X > -6 (Result of subtraction)
7

(7)x. >-6(7) (Multiply both sides by 7)
X >-42  (Final answer)
29. Select an animation and/or transition for this slide.
30. Play your presentation and make sure that it easily moves from slide to slide.

31. With your teacher’s permission, print your presentation. Save and close your file.

Memory Check

Your PowerPoint presentation should be as eye-catching and readable as possible.
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Project 12 Rubric

Name

Period

Directions: After you have finished your project, determine how well you have completed each Category. Read the

criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right

column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of Evaluation

. . . i Score and
and Corresponding Excellent (4) | Proficient (3) Developing (2) Beginning (1)
Comments:
Score:
Slide Design and The design, The design, The design, The design,
Animation animation, animation, animation, and animation, and
and and transitions are transitions are
transitions are | transitions are | somewhat not effective.
very effective. | effective. effective.

Formatting and

The problems

The problems

The problems are

The problems

contains all of
the slides in
correct order,
with no errors
in the text.

contains all of
the slides in
correct order,
with no more
than one error
in the text.

contains all of the

slides in correct
order, with no
more than two
errors in the text.

Layout of Sample are very are readable. | somewhat are not

Problems readable. readable. readable.

Slide Show The slide The slide The slide show is | The slide show
show is show is average, with two | is distracting,
engaging and | acceptable problems moving | with more than
moves easily | and moves from slide to slide. | two problems
from slide to from slide to moving from
slide. slide with only slide to slide.

one problem.

Hard copy The hard copy | The hard copy | The hard copy The hard copy

does not
contain all of
the slides in
correct order,
with more than
two errors in the
text.
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Project 13 Flipping Coins

Solution File
Academic_Project_13_SF

Topics Covered

Math Skills
e Predicting probability

Computer Skills

e Creating new slides

Adding text to slides
e Applying a design template to slides
e Applying animation to slides

e Creating an organizational diagram in a slide

Why Do I Need to Know This?

Probability and odds are used to predict the likelihood that a specific result will occur. If you were given a
choice of three different outcomes after flipping a coin four times, which one would you choose? Choices for
the outcomes are:

1. Getting all heads or all tails after four flips
2. Getting two heads or two tails in any order after four flips

3. Getting three of one side of the coin and one of the other (for example, heads-heads-tails-heads ).

Would you be able to select the outcome with the highest probability? In this project, you will create a chart in
PowerPoint to help you determine the answer to this question.

Procedure
1. Open a new PowerPoint presentation.

2. Save the file as Academic_Project_13-[first initial][last name]. Ask your teacher where to save the
file.

3. Choose a design theme and/or color scheme for your presentation. Your first slide should be in Title
Slide format. Title the slide Coin Flip Probability. In the subtitle box key: Heads or Tails? Add Clip
Art of a coin below the subtitle.

4. Create a new slide. Choose the Title and Content layout for this slide.
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Project 13

5.

6.

10.

11.

12.

13.

14.

15.

Title the slide First Flip.

Click in the Content box. Choose Insert>Illustrations>SmartArt. In the Choose a SmartArt
Graphic dialog box, click Hierarchy and click OK.

In the top shape of the chart, key the word Coin.
Delete all three shapes in the third tier of the chart.

Key the letter H, for Heads, in the left shape and the letter T, for Tails, in the right shape. Change the
background color of the Tails shape.

Create a new slide, choosing the Title and Content layout again.

Title the slide Second Flip.

Repeat steps 6 and 7.

Right-click the last shape in the bottom row, click Add Shape, and then click Add Shape After.
Label the shapes as shown in Figure 13.1.

Change the background color of all the Tails shapes. (See Figure 13.1 below for an example.)

Figure 13.1 Second Flip

Second Flip

‘ Coin

Heads Tails

16.

Create a new slide, choosing the Title and Content layout again.

17. Title this slide Third Flip.
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18. Create a chart having the same structure as the one shown in Figure 13.2.

19. Label the shapes as shown in Figure 13.2. Change the background color of all the Tails shapes.

Figure 13.2 Third Flip

THIRD FLIP
B
3 B

EEEEEREE

20. Create a new slide, choosing the Title and Content layout again.

21. Title the slide Fourth Flip.
22. Create a chart like the chart on the Third Flip slide.

23. Create two subordinate shapes for each of the shapes on the bottom row of the chart. Title the new
subordinate shapes Heads or Tails, as appropriate. You should have 31 shapes all together. Change the
background color of the Tails shapes. (See Figure 13.3 for an example.)
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Figure 13.3 Fourth Flip

FOURTH FLIP

24. Create a new slide, choosing the Blank layout.

25. Create a text box and then key in the following questions, as well as answers to these questions:
a. How many paths are possible after four flips?
How many paths are possible with all heads or all tails?

c. How many paths are possible with two heads and two tails? (The order of the heads or tails does
not matter.)

d. How many paths are possible with three heads and one tail or three tails and one heads? (The
order of the heads or tails does not matter.)

e.  Which type of path is most likely?
26. Apply an animation scheme and/or a transition to the each slide.
27. Play your presentation to make sure that it easily moves from slide to slide.

28. With your teacher’s permission, print your presentation. Save and close your file.

Memory Check
You can calculate the ratio of possible outcomes by dividing the number of paths that lead to each outcome by
the total number of paths.
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Project 13 Rubric

Name Period Date

Directions: After you have finished your project, determine how well you have completed each Category. Read the
criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right
column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of Evaluation

enhance the

not detract

presentation but

from content in

. - . - Score and
and Corresponding Excellent (4) | Proficient (3) Developing (2) Beginning (1)
Comments:
Score:
Slide Design, The design, The design, The design, The design,
Animation, and animation, animation, animation, and animation, and
Transitions and and transitions do not | transitions
transitions transitions do | detract from the divert attention

responses to
the probability
questions.

responses to
the probability
questions.

responses to the
probability
questions.

overall from the are not pleasing the
presentation. | presentation. | to the eye. presentation.
Organizational The charts on | There is one There are two There are more
charts each slide are | error in the errors in the than two errors
drawn charts. charts. in the charts.
correctly.
Probability questions | There are no | There isone | There are two There are more
errors in the error in the errors in the than two errors

in the
responses to
the probability
questions.
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Project 14 Looking at Medals

Solution File
Academic_Project_14_SF

Topics Covered
Math Skills

e Comparing data

e Creating bar graphs

Computer Skills
e Adding text to a slide

e Creating a chart
e Applying a design template

e Applying an animation scheme

Why Do I Need to Know This?

Professional sports are big business in the United States and around the world. The National Football League
(NFL) consists of 32 teams divided into two conferences. Its season culminates with the Super Bowl, an event
watched by hundreds of millions. NFlgames provide large revenues for their home cities, teams, players,
owners, advertisers, and many other professionals.

Because of the intense interest in professional football, fans closely watch the performances of teams and
individual players. In this project, you will create a PowerPoint presentation containing charts that compare
two teams with an intense ongoing rivalry: the Chicago Bears and the Green Bay Packers. First, you will create
a chart showing each team'’s total regular season wins for a ten-year period. Then you will create a chart
showing each team’s total season touchdowns during this same period.

Procedure
1. Open a new PowerPoint presentation.

2. Save the file as Academic_Project_14-[first initial][last name]. Ask your teacher where to save your
file.

3. Go to the Design tab and choose a theme for your presentation. You also may wish to change the
background color of your slides.

4. Title the first slide Comparing Two National Football League Teams. Key: The Chicago Bears
Versus the Green Bay Packers into the subtitle text box.
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5. Create a new slide that uses the Title and Content slide layout.
6. Key in the title Wins: Bears Versus Packers.

7. To create your chart, click Insert Chart in the Content box. In the Insert Chart dialog box, double-
click Clustered Column (first column, first row).

8. Key the data in Figure 14.1 into the datasheet. The Bears total wins are listed first while the Packers
wins are listed second. Enter the data into the datasheet as shown in Figure 14.2.

Figure 14.1 Bears and Packers Regular Season Wins

Figure 14.2 Sample Datasheet for Bears and Packers Wins

A B C

1 Bears Packers

2 2000 3 9
3 2001 13 12
4 2002 4 12
5 2003 7 10
s} 2004 3 10
F 2005 11 4

9. Label both the vertical and horizontal axes of your chart.

10. When all of the data are entered, your chart should look similar to Figure 14.3.
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Figure 14.3 Chart Comparing Bears and Packers Wins

Wins: Bears Versus Packers

M Bears

Packers

2001 2002 2003 2004 2005 20006 2007 2008 2009

Year

11. Create a third slide that uses Title and Content slide layout.
12. Key in the title Touchdowns: Bears Versus Packers.

13. To create the chart, click Insert Chart in the Content box. In the Insert Chart dialog box, double-
click Clustered Column (first column, first row).

14. Key the data in Figure 14.4 into the datasheet. The total touchdowns for the Bears are listed first while
the touchdowns for the Packers are listed second. Be sure to enter the data into the chart so that the
dates appear along the vertical axis of the chart. Your chart should look similar to Figure 14.5.
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Figure 14.4 Bears and Packers Regular Season Touchdowns

Year | Bears | Packers
2000 22 36
2001 37 47
2002 31 45
2003 29 33
2004 26 20
2005 28 34
2006 47 32
2007 34 49
2008 42 48
2009 36 34

Figure 14.5 Chart Comparing Bears and Packers Touchdowns

Touchdowns: Bears Versus Packers

B Bears

L]
=
=
=]
o
=
[
5
s

Packers

2000 2001 2002 2003 2004 2005 2000 2007 2008 2000
Year
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15. Label both the vertical and the horizontal axes of your chart.
16. Apply appropriate animations and/or transitions to each slide.
17. View your presentation to make certain that it works properly and is error-free.

18. With your teacher’s permission, print your presentation. Save and close your file.

Memory Check

When you are done creating a chart, always take a minute to look at the “big picture.” Will the reader find the
chart easy to understand? Do the data make sense? By doing this, you can make your chart easier for people to
grasp.

Source for data in Figures 4.1 and 4.4:
NFL: Standings. NFIEnterprises LLC. 8 October 2007 <http://www.nfl.com/standings>.
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Project 14 Rubric

Name Period Date

Directions: After you have finished your project, determine how well you have completed each Category. Read the
criteria under each column—Excellent, Proficient, Developing, and Beginning. Give yourself a score in the right
column based on how well you think you met the criteria. Turn in this paper to your teacher along with your project.

Areas of Evaluation S d
and Corresponding Excellent (4) | Proficient (3) Developing (2) Beginning (1) gore an
Comments:
Score:
Slide Design The slide The design is | The design is The design is
design easy to read consistent from not consistent
enhances a and slide to slide but and is a
slide’s consistent distracts distraction.
readability. from slide to somewhat from
slide. slide content.
Slide Animations and | The The The animations The animations
Transitions animations animations and transitions and transitions
and and somewhat are not effective
transitions transitions do | distract viewers and distract
enhances the | not distract from slide viewers from
presentation. | viewers from content. slide content.
slide content.
Accuracy of Bar The graphs The graphs The graphs The graphs do
Graph Data contain all of contain all of contain all of the | not contain all
the data. All the data. Less | data. More than of the data.
entries are than three three entries are More than three
correct. entries are incorrect. entries are
incorrect. incorrect.
Bar Graph The x- and The x- and The x- and y-axes | The x- and
Appearance y-axes of the | y-axes of the | of the graphs are | y-axes of the
graphs are graphs are correctly labeled, | graphs are not
correctly correctly the key is not correctly
labeled, the labeled, the correctly labeled, | labeled, the key
key is key is and the data are | is not correctly
correctly correctly too close. labeled, and the
labeled, and labeled, but data are too
the data are the data are close.
easy toread. | too close.
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